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NMBS WaMP
WaMP stands for Watershed Management Program. Not overly inventive, but at least it replaces that sound that all
of the paper data used to make when you put it on your desk. The program is provided freely by NMBS to any
non-profit or governmental agency seeking to manage environmental data; this manual was funded as part of a
Growing Greener grant.

This manual will attempt to give you a roadmap on how to use the program. It is broken up into sections which
explain the usability themes, the various components, the known bugs,  some general technical yammering (yawn)
as well as a sneak preview for items planned for future releases.

Version
This manual covers version 1.0.1. To check the version of the software you have, both the splash screen (the screen
that appears immediately after you have logged in) and the About box display the version in the lower right hand
corner of the (respective) screen. You can also check the version on the executable in Windows, if you know how.

Installation
To install  NMBS WaMP, you probably want to create a temporary folder to be used for this purpose. Once created,
unzip the setup.zip file in that directory.

Once setup.zip is unzipped, close out of all applications and  run setup.exe from the directory which contains the
unzipped files.

Your machine should now display a blue screen which says “NMBS WaMP Setup.” Click on the OK button.

The next screen will allow you to install the application as well as change the directory where the program is being
installed. If you wish to change the directory, press the “Change directory” button and select the directory you wish
to use. Otherwise, the program will be installed inside of your “Program Files” directory in a directory named
“NMBS WaMP.”

Once you have the “correct” directory selected, press the big button in the top left corner of the setup dialog. This
will start the installation process. The next dialog you should see is one indicating that the setup was completed
successfully.

Getting Started
After you have successfully installed NMBS WaMP, you can now start using it. The install process has added a
shortcut in your Startup-Programs. Click on that menu choice (the icon looks like the Earth).

When you first run NMBS WaMP, you will get a login screen. This exists to allow users who want to secure their
database to do so. The user ID and password at this point are:

User Id: Admin
Password: (i.e., leave it blank)

Once you have entered the user id and password, NMBS WaMP will check for your database. Since this is the first
time you are using the application, there is no database. You are asked if you would like to create the database.

Click on the “Yes” button.
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You will then be prompted for database detail information. You must enter a database name. You do not have to
enter a purpose. The database name and purpose are for your use going forward, so you should enter something in
these fields which will help you identify this database. If you are just using this database to get acquainted with
NMBS WaMP, then you might want to enter “test” or “sample” for the database name.

Once you have entered the database name, press the OK button.

Bug:
In version 1.01, there is a bug at this point. The application never appears. Press Clt-Alt-Delete and end the
application. When you re-run the program and log-in, you will gain access to the database you just created.

What’s next
Once you get into the application, you will need to accomplish the following tasks:

1. Add parameters
2. Create one or more types
3. Stop and figure out how you want to organize your data (spatially). Determine what is an area, what is a

site, and what is a monitoring point.
4. Add one or more areas
5. Add one or more sites per area
6. Add one or more points per site
7. Set the type for each point with sample data
8. Add sample data to each point

The above list was included both to provide you with a quick overview of the order of events and to note that the
order for each of these items is  dependent upon the previous steps (essentially, see  next paragraph for exception).
That is, although you can add sampling data whenever you want, you will not be able to add any sample data for a
point until you have completed steps one through six for the point in question. As an additional example, you cannot
add a point until you have added a site; you cannot add a site until you have added an area.

Steps one and two are not expressly required for steps three and four, but they are required for steps six and seven.

Usability themes

Organization of data
Primarily, this system centers on the collection and maintenance of sampling data. Since all sampling data is
associated with a physical location, the data is organized based upon points and groups of points.

Essentially, data is broken up into several levels. Samples are associated with the smallest of three levels, but you
can define the levels as best fit your needs.

Starting at the top and working down, the levels are areas, sites, points. While there are a number of other types of
data (organizations, people, counties, towns, and types), the other types all support your sampling data.

One possible organization of the areas and sites is to have each area represent a watershed and each site represents a
sub-watershed. Points then are specific sampling points on a site (sub-watershed). The difficulty is in what is defined
as a watershed. That is left to you ☺. Given the number of different sets of data that we have worked with over the
years, it is amazing that all of them can easily fit in three levels of data. So, this program has three levels. If you
want or need more, then consider either creatively naming your areas, or using different databases for different
“super-areas.”
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Another possible organization of areas and sites would be to have an Area represent a logical segmentation of the
data rather than a geographic one. For example, Area 1 could be “historical” and area 2 could be “GG Grant 98.”
We’ve seen both approaches used successfully.

If you aren’t sure how to use the areas and sites, we recommend that you use the watershed and sub-watershed
approach.

Ultimately, the only important thing is that you have three levels of data and that each sample must be associated
with a monitoring point which must exist on a site which is part of an area. For example, my sampling point SR029
is on Trout Run in the Moshannon Creek Watershed (point, site, area). Another successful use I’ve seen is: SR029 is
on permit 1411124 which is on Trout Run  (point, site, area). In the latter case, the database could be for Moshannon
Creek, which provides a “hidden” fourth level.

Menus
Menus should behave as expected for anyone accustomed to Microsoft Windows based applications. This means
that you can use the mouse to select a menu, or any of the following key combinations:

• If a letter in a menu is underlined (e.g., File) then you can access that menu by holding down the ALT key and
pressing the underlined letter (e.g., ALT-F). Once you access a menu, submenus can be accessed by moving
within the menu with the arrow keys and then pressing ENTER on the desired submenu entry or by pressing the
letter underlined ,if any (e.g. ALT-F S for File Save) ; the ALT key is not required once the menu is opened.

• ALT-SPACE opens up the “Control menu” and can serve as a generic point of entry for all of the menus.
• ESC will cancel out of any open menu.
• Some menus also have shortcuts listed to the right of the menu text. The keyboard combination listed there can

be used as a short-hand way of accessing the menu. (e.g., CTRL-C will behave the same way as ALT-E C or as
using the mouse to select the Edit menu and then choosing the Copy option).

In this application, menus are often context sensitive. This means that File-New will add a new item which is
appropriate for the active screen. In the Site screen, this means that File-New will add a new Site; in the Point screen
File-New will add a new point. However, if there is no action for the current screen, then the menu choice will try to
do the appropriate thing for the next highest context. For example, File Open on the Area screen doesn’t mean
anything, so the program assumes you want to open a new database and will prompt you to do so.

Toolbars
Toolbars should also behave as expected for anyone accustomed to Microsoft Windows based applications. There is
one toolbar for the application as well as additional toolbars on several of the screens.

• All toolbar buttons should have a tooltip which briefly describes the function of the toolbar button. To see the
tooltip, put your mouse on top of the button, but don’t click. A small yellow box will appear with the
descriptive text.

• Clicking on the toolbar button will perform the specified action. For example, clicking on the Paste Toolbar
button (seen at the left  will perform the same action as selecting Paste from the Edit menu or pressing the
shortcut keys of CTRL-V).

In this application, toolbars are often context sensitive. This means that clicking the New button  ( ) will add a
new item which is appropriate for the active screen. In the Site screen, this means that it will add a new Site; in
the Point screen it will add a new point. However, if there is no action for the current screen, then the menu choice
will try to do the appropriate thing for the next highest context. For example, the Open  button ( )on the Area screen
doesn’t mean anything, so the program assumes you want to open a new database and will prompt you
to do so.
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Grids
A number of the screens use grids for data entry and review. All of the grids should behave in a number of similar
and consistent ways. When you can use one grid for data entry, you should be able to use any grid for data entry.

The similarities relate to navigation, toolbars, and display.

Navigation
You can use the mouse to move around cells in a grid in any fashion that you like.

The following keys can be used to navigate a grid. When more than one key combination appears in a cell (e.g., both
SHIFT-TAB and ←  (arrow left) appear in the first cell), this means that any of these key combinations can be used for
the specified purpose.

SHIFT-TAB
←  (arrow left)

Either of these keys or combinations of keys will move the active cell to the left of
the current one. . If the active cell is in the first column, then Tab will move the
selection to the prior control on the form (i.e., out of the grid); the arrow left will
not change the selection in this context.

TAB
→  (arrow right)

Either of these keys will move the active cell to the right of the current one. If the
active cell is in the column on the furthest right of the screen, then Tab will move
the selection to the next control on the form (i.e., out of the grid); the arrow right
will not change the selection in this context.

↑ (arrow up) This key will move the active cell to the cell above the current one. If the current
cell is in the first row in the grid, then nothing will happen.

↵  (ENTER)
↓ (arrow down)

Either of these keys will move the active cell to the cell below the current one. If
the current cell is in the last row in the grid, then nothing will happen.

CTRL-HOME This combination of keys will move the active cell to the first row in the current
column.

CTRL-END This combination of keys will move the active cell to the last row in the current
column.

HOME This key will move the active cell to the first column in the current row.
END This key will move the active cell to the last column in the current row.
ESC If a cell is being edited, this will discard the changes in the cell and will take the

cell out of edit mode. If the cell is not being edited, then this key has no effect.

Whenever a row is left, any edited data is committed to the database (saved). On some screens, the data is
committed after the cell is left. In all instances, however, you can undo a change until you leave a row. To undo a
change, click back on the cell you edited and hit the ESC key. Note that if you click on a menu or toolbar item or if
you click on another screen, you have effectively left the row and the data will be committed to the database.

When you are actively editing the data in a row in a grid, the leftmost column in a grid (commonly called the record
selector) will have a pencil in it. When the icon in the cell is a triangle (u), then you are not in edit mode and the
triangle is just indicating the active row.

To enter a new record, click in the last row in the grid. If it has an asterisk (*) in the record selector, then this is the
“new record” row. The existence of this row does not indicate that there is data in the database for this row, instead
it is an indicator of where you can type to add new data.
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Display

Toolbars

Multi-row Save layout
  display Alternating row Revert to saved layout

color

Alternating row display: This button causes odd and even rows to display with different colors so that you can
more easily distinguish between them. This is the default when you first install the application. You can change this
by clicking on the toolbar option. To change this for all grids and/or for every time you access the program, look at
the section on Tools-Options. See Figures 1 and 2 for a sample of alternating row display.

Figure 1 Alternating row colors

Multi row display: Displays all of the data for a record in multiple rows before displaying the next record. This is
particularly useful if there are a lot of columns which don’t fit on the screen; rather than having to scroll to the right,
you can display all of them. If this feature is used, it is almost imperative to use the alternating row coloration. To
change this for all grids and/or for every time you access the program, look at the section on Tools-Options. See
Figure 2 for a sample.

Figure 2 Multi-row display
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Layouts: In all grids, you can resize the width of a column by grabbing the column head and dragging to the right or
the left. However, you may want a particular width to appear every time that you load a particular screen. In most
screens, this can be accomplished by saving the grid layout. If you later change your mind and want to “start over,”
then you can do so by “reverting to the default layout. The saved layout can be set back to the default layout by
reverting to the default layout and saving that layout.

Screen
The application operates in a MDI (Multiple Document Interface) window. This is computer geek language which
means that any window, except dialog boxes, you open in the application will always stay within the bounds of the
main window. This is the same behavior that you are used to seeing with most Windows programs (prior to XP ☺).

Two additional features of the main window are the title bar and the status bar. The title bar appears at the top of the
window. It will display the active database’s description (see Define Database).

The status bar appears at the bottom of the main window. It provides several pieces of useful information. These are,
in order, the active area, the active site, the active point, the status of the insert key, the status of the caps key, and
the current time. An example of the status bar appears below.

Managing Types
This is likely to be the most confusing section of this document (other than perhaps the section on filtering).
However, it is also one of the most important and understanding the concepts presented here are critical for anyone
setting up a database to be used in NMBS WaMP.  The approach outlined in this section is also the reason that this
application may be superior to some others: the structure of this application allows it to be used consistently across
different needs without modification; this contrasts with many solutions which need to be modified for each distinct
data need.

That said, the basic idea is that all result data exists for a particular set of parameters. These sets of parameters are
called types. Types are used to enter and view data on the point level (that is, each point is of a particular type). You
can define a type for anything. Types might be sets of parameters for: a discharge, a stream, a macroinvertebrate
sampling, or a bio-waste study.

Parameters
Management of parameters occurs by using the parameter feature. Access this by using the Data menu and selecting
Parameters. The basic details of this appear under Features-Parameters.

You must first enter a parameter in order to use it in other situations.

Types
A “type” is essentially a set of parameters. By defining a type, you are indicating that you expect to see a particular
set of parameters together. The concept of a “type” is very powerful and can be used in a number of ways to enable
you to both enter and review data.

Points are expected to be of a particular type. The type that you assign to a point will define what parameters appear
in the sample grid for the selected point. This has obvious value for data entry, for example, the sample grid needs to
display flow, pH, iron, and aluminum in order for you to record this information.
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Someone familiar with databases might equate a type with a table. While this seems to be conceptually true, the
reality is that the data is retained independent of the type. This allows you to switch types on a point without losing
or adding any data to the database.

This concept of switching type has particular value for both data entry and data review. If, for example, you want to
retain up to twenty different parameters for each “stream” points, but you are entering data from historical sampling
which only contains data for six of your parameters, you may want to identify a point as “stream,” but temporarily
change the type to “historical stream” when entering the data.  This approach would make it easier to enter the data
since only the six parameters would be displayed and you would not need to scroll around a lot to find the data you
wanted to enter. Once you finish entering the data, you would probably want to switch the type back to the
appropriate “stream” type.

NOTE: At this time, parameter order in types is fixed. This is a planned enhancement which will make data entry
from forms an even easier task (so that columns can be defined in the same order as they exist on the form).

Although you can change a type at any time, you are encouraged to only change types for data entry ease-of-use or
because the type is actually “wrong.” Again, changing a type, however, does not affect what data is retained: it only
changes what data is displayed in the sample area of the point screen.

For information on how to define a type, see the section under Features labeled “Types (Define Types).”

Features

The following text outlines each of the features in the application. In general, these features will correspond to the
menu choices that will get you to the features. The menu options will be noted in parentheses in the heading.

Areas (Data-Area*)
You can enter and edit areas by launching the Area screen.  Areas can only have a basic name and a description. As
in all editable grids, click in the last row (an asterisk (*) will appear in the record selector) and start typing.

Clicking on area makes it the active area for application. This can be seen by looking in the status bar at the bottom
of the screen.

* Note that if you choose to change the description “Area” (see Tools-Options) then the menu heading will also
change and the keyboard shortcut will no longer exist.

Calculator (Tools Calculator)
This provides a simple calculator which can provide very basic math. It is less sophisticated than the one which
comes with Windows, but it stays within bounds of parent form and closes with application.

Configuration Options (Tools Options)
There are a number of ways in which you can configure the way that the application performs. Other than grid
layouts, all of these options are grouped together and made available via the Options dialog box.  These values are
then stored in your registry and remain persistent across executions of the applications.

This dialog has three tabs: File, Format, and General.

Once you have set the options to the settings you want to apply, click the OK button to apply them. If, on the other
hand, you don’t want the changes applied, then press the Cancel button.
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File
The File tab allows you to specify the directory where the data is stored, the directory where the application puts a
“scratch pad” or temporary file, and the database which stores filter and result set definitions. The first two may be
the same if you are the only user of the application, but they are specified separately for those instances in which
you are on a LAN and want to store the permanent database somewhere where it is backed up, for example.

NOTE: This program was not written or tested for multi-user access. It may work with multiple users, but that may
cause odd errors. On the other hand, some of the code which was scavenged from other projects was written for
multi-user access – so it might work. No promises either way ☺.

Filter and result set definitions are stored in their own database. This allows you to have the same ones across
multiple databases. You may also share these databases with other users on the same LAN. If you do the latter,
however, then it is important that you each have your own login ID. If you want to do this, you should read the
section on security.

Format
The Format tab allows you to specify the “standard” behavior of grids as well as the configuration of CSV exports.

The first two check boxes control the default behavior of grids. They control the display of records in rows and
whether records alternate coloration.

If you enable the “Display multilines for grids” checkbox, then grids will default to displaying all columns in a
record on multiple rows prior to displaying the subsequent record.  If this box is not checked, then each row in a grid
represents a separate record.

The second checkbox “Alternate colors for grid rows” will cause even and odd records to display with different
colors. If this box is not checked, then all records will be displayed with the same background color. The distinction
between records and rows is important here as a grid with “multiline” display will still display a single record with
the same color, even if it spans several rows. In fact, multiline displays are even harder to read without the
alternating color option.

The last two options are ones which you are not likely to use much. In general, you want the text separator to be a
double quote and the field delimiter to be a comma. These values correspond to the values that are expected in a
CSV (proper) file. However, there are times in which you want to have different values in these fields; for example,
your data might liberally use double quotes – which will cause problems in an export.

The text separator refers to the character used around text fields.  As noted above, if your text includes double
quotes, then using the default character for denoting text would cause a mess. Changing the character to a tilde (~)
or a curly brace (e.g., {) might resolve your problem.

The field delimiter denotes the character used to identify a new field.

Example with double quote (text separator) and comma (field delimiter):
"Area","Point","Sample Date","Company Name","Type","pH","flow"
"area 1","mp 1 d","1/1/03","Old Dryfus Corp.","discharge","",""

Example with left curly brace ({) and  and semi-colon:
{Area{;{Point{;{Sample Date{;{Company Name{;{Type{;{pH{;{flow{
{area 1{;{mp 1 d{;{1/1/03{;{Old Dryfus Corp.{;{discharge{;{{;{{

As the two above examples should make clear, this is simply a case of changing the characters used to represent the
separator and delimiter. These are options that exist for those situations where you need them. Otherwise, these are
probably two options you don’t want to change.

NOTE: If you need to export data for use in a spreadsheet program such as Excel, then you should leave them as is.
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General
The General tab allows you to enable the application to remember your userid, rename areas, rename sites, and load
a default filter.

The login screen exists to allow those users who wish to secure their data to do so. For more information on this, see
the section on security. For everyone else, the login screen is probably more of an annoyance than anything. So, the
program allows you to remember your userid from session to session. Since some people will use this even in a
“secure” environment, the application won’t remember your password. However, if you have an empty password
and check the “Remember user ID” checkbox, then you can just click OK on the login screen without having to type
anything at all. If your database is secured, we recommend that you do not enable this feature as it increases the
likelihood that someone can hack into your system.

The ability to change the name of areas and sites is there only for those of you who don’t like the labels “Area” and
“Site.” If it helps you to rename them, then do so here and the names will change everywhere in the application;
even exported data will be identified with the text you enter here.

Finally, the Default Filter text box is there to allow you to load a filter that you have saved (see section on filtering)
immediately upon loading the database. This is particularly useful if you are working with a particular subset of the
data over several days or if you always work on a particular subset, but share the database with someone else. Once
loaded, this filter will be applied and will become the active filter.

Configuration options will be stored locally on a computer and will be reloaded each time the application is
launched.

Counties
This screen allows you to maintain basic information on counties: State, county name, and FIPS code. Counties can
be added or edited using the standard techniques for a grid.

Exports (File Export … )
Exports are made using the active filter. Two of the exports, CSV and GIS, only export data selected in the Results
screen, and the third, the DB Export, exports all data for the relevant filter and all support data (people,
organizations, parameters, types … ).

In each instance, once you select the Export type, you will be prompted to select the destination filename(s). This
selection will be done using a standard File-Save dialog. Once you select them, the application will attempt the
export.

DB
The purpose of this export is to create a new database which is populated with an extract of the current database.
The extract will be limited to the data which is selected by the current filter. If there is no filter, then this command
creates a duplicate copy of the active database.

Once you have selected to export a database, you will need to specify the name of the new database and the system
will create that database and export all areas, sites, points, and samples which match the active filter. All parameters,
types, counties, townships, organizations, and people will be copied to the new database.

The new database will not be opened automatically. Once the new database is opened, you will need to enter in the
DB info.
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GIS
This export will create a shape file for use in a GIS program which can read the ESRI shape file format. All data in
the current result set will be exported using the active filter.

Once you have selected GIS, the system will ask you for the name of the file that you wish to create with this export.
If that file already exists,  it will be overwritten. The filename must be 8 characters or fewer to be read by many GIS
programs. The export will create a .shp, .shx, and .dbf file with the specified file name in the selected directory.

You must have a result set in order to do a GIS export. If you do not have a result set, the system will remind you
that you must.

All fields in the resultset will be exported with the heading as close as possible to your field names. Any field name
which contains spaces or which is longer than eight characters will be adjusted as best as is possible (spaces will be
stripped, and only the first eight characters will be used). However, if you have two field names which come out the
same (e.g., Alkalinity and Alkalinity Load), the first will be used (e.g., Alkalini) and the second will be dropped in
favor of a system specified name. The system specified name will be “fld” and a number which is likely to
correspond to the column number (e.g., fld9).

All parameter data will be exported with the qualifiers, if any, that have been applied.

CSV
This export will create a text file with the text separator and field delimiter that have been specified in the
Configurable Options (Tools Options). By default, these are a double quote and a comma.

Once you have selected CSV, the system will ask you for the name of the file that you wish to create with this
export. If that file already exists, it will be overwritten.

Parameter data will be exported with any qualifiers which have been applied. This means that the data will be
textual. If you are intending to use the values as numbers, then you will need to remove the qualifiers. In Excel, you
can use the following formula to accomplish this:

=IF(ISNUMBER(<cell>),<cell>,VALUE(RIGHT(<cell>, LEN(<cell>)-1)))
e.g., where the qualified data is in F11 (put this formula in a different cell):

=IF(ISNUMBER(F11),F11,VALUE(RIGHT(F11, LEN(F11)-1)))

Filtering
Filters allow you to reduce the set of data that you are using.  This can be useful for both analytical purposes (e.g.,
you want to review all points with a pH < 4 and flow > 200 gpm), quality control (e.g., you want to find all points
which have a pH > 7 and Fe > 400), or data entry (e.g., you only want to work on the data for Little Laurel Run).

There are two ways to work with filters. In general, you are probably going to use the Simple Filter. It will allow
you to reduce the visible set of data based upon several criteria which are all true. However, there may be times in
which you want the ability to do a more complex limitation. For example, you may want to show all samples on
Little Laurel Run or any sample on Morgan Run which has a pH between 4 and 6. The more complex queries will
need to be done using the Advanced filter.

If you create a filter which returns no records, the application will tell you as much and will not apply your filter.

Saving and Loading
Both simple and advanced filters can be saved and reloaded at a later date. Both screens have a field at the very top
which is titled “Filter name.” This is the name of the filter that you are currently using. When you attempt to save a
filter (File-Save or press the Save icon (  ) on the toolbar), then this is the name which will be
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saved to identify the active filter. If a filter with that name has already been saved, then you will have the option to
overwrite the existing filter or to cancel and rename your active filter.

To open a saved filter, press the Open icon on the toolbar ( ). A dialog will pop up which will list all of the
filters which have been saved for the appropriate filter type. That is, you can only load a saved simple
filter to the simple filter screen; you can only load a saved advanced filter to the advanced filter screen.

Simple
The simple filter screen allows you to enter a value for the Area, and Site, and Point, and Date (start and end dates),
and up to four parameters. The reason that I used the word “and” so many times in the last sentence was to drive
home the point that everything in the Simple Filter screen will limit the results of the filter. In this case the filter is
for an Area and flow and pH.

The Area, Site, and Point values are all compared against your data using a “LIKE” operator. What that means to
you is that any value that you enter here will be the START of the value in the database. For example, in the screen
above, I was asking for any Area name that started  with the letter “a.” Also, unlike some programs, this application
does not distinguish between upper and lower case. So, this filter would accept areas named “armadillo”, “apple”,
“Anderson Creek”, and “aaaaagh.” It would not, however, let you see areas named “barb”, “laurel run”, or “please
please please” as none of these names starts with the letter “a.”

The date filtration is done for all dates which are greater than  the start date and/or less than  the end date. This
means that a start date of “1/1/03” and an end date of “12/31/03” would return all data sampled in 2003 except
January 1st and December 31st. To include all dates in 2003, you would need a start date of “12/31/02” and an end
date of “1/1/04.”

Finally, you can select up to four parameters. The combo boxes list all parameters in your database and allow you to
search for values which are >, <, or = (greater than, less than, or equal to) the values you enter.  You can enter a
parameter more than once if you wish; in fact, you will have to do so if you want to select values in a range. For
example, to get all values which have a pH between 3.2 and 6.4, you would need to have (at least) two rows. One
would request a pH > 3.2 and the other would request a pH of < 6.4.

The reason I used the text “at least” in parentheses at the end of the last paragraph is that the computer is very literal;
if you ask for all values with a pH > 3.2 and a pH < 6.4, then you will not get values of 3.2 or 6.4. If you actually
wanted these, then you would have to determine an acceptable increment (e.g., pH > 3.19999 and pH < 6.40001)
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and live with the slight inaccuracy. If you cant accept this, then you will have to move to the advanced filter. You
cannot enter four pH lines (pH = 3.2, pH > 3.2, pH < 6.4, pH 6.4) as this would return no records. Remember, each
condition is an “AND” condition. There is no value which is both equal to 3.2 AND greater than 3.2. The first
example (pH > 3.2 and pH < 6.4) is acceptable because there are a number of values which are both greater than 3.2
and less than 6.4.

Advanced
If you need to select records that meet an “or” condition, or which have more sophisticated grouping options, then
you will need to use the Advanced filter.

If you have already defined a simple filter, then the application will convert it to an advanced filter. If you want to
access the advanced filter and discard the simple filter, then click “No” when you are asked if you want to convert

the simple filter.

In the example filter displayed above, the filter is actually the equivalent of saying that you want to see all samples
which are in the area named “area 1” and have a site starting with the letter “s” or have a pH greater than 4 and a
flow less than 200 gpm or have Aluminum > 14 mg/l.  (Actually, units are being assumed. You define the units
when you define the parameters.)

This example was used to illustrate several features of the advanced filter. These include grouping (the left and right
parens that appear in the little white boxes), the addition of “OR” criteria, and the fact that you can now make exact
matches on Areas, Sites, and Points.

Grouping is enabled by clicking on the white box between the conjunction and the field name (e.g., OR “(“ pH) or
the white box on the far right. Clicking in either of these boxes will switch an empty box to a paren, or a paren to an
empty box (i.e., it is either on or off). This grouping is exactly the same as grouping in most structured query
languages and in mathematics. As an example, (3+4)*(2+1) is very different from 3+4*2+1. The former equates to
21, while the latter equates to 12.

In the advanced filter screen, you now have the ability to use the “OR” conjunction; this contrasts with the simple
query where you were only allowed to use the “AND” conjunction. The addition of the “OR” conjunction allows
you a lot more flexibility. For example, you are now able to find samples with a pH value which is greater than or
equal to 3.2.  (pH > 3.2 OR pH = 3.2).

There is also a “NOT” conjunction. This text will only mention that it exists and that it is really only useful in the
first position. At some point we will correct that oversight so that there are “NOT”, “AND NOT”, and “OR NOT”



NMBS WaMP 13

options. The not is exactly what it sounds like: you can choose something which does not fit the filter criteria (e.g.,
the area is NOT = “area1” will display all samples which are in an area other than the one named “area1.”

Theoretically, there is no limit to the number of conditions that you enter here. Once you exceed the number of rows
on the screen, a vertical scrollbar will appear and allow you to move up and down between the filter items.

In the lower left corner of the screen you will note instructions on how to delete a row that you do not want in your
filter. Hold down the SHIFT key and press the DEL key. This will delete the active row from the filter.

Clear filter
This will clear the filter. All open screens will be “notified” that the filter has been removed and will revert to
showing all the data that is appropriate. These screens will not be updated, however, until you click on them or
otherwise make them the active screen.

Login
This screen is what it says it is: enter the appropriate user id and password to login.  This screen allows you to either
login or change the password for the specified user.  Without the right user id and password you cannot do either of
those tasks.

Initially, the user id  is “admin” and the password is blank.

Enter the appropriate user id in the first text box (labeled “User ID”) and the correct password in the second text box
(labeled “Password”).

To enter the application, press the OK button.

To exit the application, press the CANCEL button.

To change the password, press the Change Pwd button. This button will launch another dialog in which you must
enter the new password in both boxes. If the text in both boxes matches, the new password will be applied when you
press the OK button; press the CANCEL button to avoid changing the password. You will be prompted to fix the text if
the two boxes do not match when you press the OK button.

Organizations (Data Organizations)
The organizations screen allows you to enter and keep track of all organizations. Organizations can be coal
companies, watershed groups, governmental agencies, philanthropic organizations, or any other type of organization
that you want to enter. The primary purpose for including this listing in the application is to sites with organizations.

This is a “standard” listed screen; that is, a list of existing entries appears in the box on the left of the screen and you
can click on any name to make it the active organization. You can edit the active organization and keep track of the
following types of data:

a. Organization name
b. 3 lines of address information
c. City
d. State
e. zip
f. zip4
g. phone
h. URL for organization’s website
i. active status (y/n)
j. notes



NMBS WaMP 14

Any of the items listed above (except name) which don’t have a title on the screen will have a tooltip which will
identify the field. For example, the first address line isn’t expressly labeled, but if you put your mouse pointer on the
2nd blank box, it will show you a tooltip which indicates that it is for “Address line 1.”

Parameters (Data Parameters)
You can enter as many parameters as you like. There are four fields in this grid: name, units, lowest value, and
highest value.

You should enter a unique name for each parameter. Other than that, there are no particular limitations on what is in
the name field. Even though there is a separate field for untis, you may want to include units in the name in those
instances in which you need to have the same parameter available for different units (e.g., temp: you might want to
have parameters such as “temp (C)” and “temp (F)”)

The units are exclusively for your use and reference. They are not actually used in the application at this time.

The lowest and highest values are used for data validation. When you enter data in the sample grid, the value entered
will be checked against the lowest and highest values you have specified. If the value entered is not within these
bounds, the user will get an error message and the data will not be accepted. Therefore, it is important to use values
which are

The parameter grid conforms to standard grid usage. You can both add and edit parameter data.

Although you can edit parameter data, you are STRONGLY encouraged to refrain from editing existing
parameter values unless you are absolutely certain of the implications of your actions. This is because
parameters are one of the “backbones” of the application and changing a parameter can have widespread
implications. All data refers to an internal ID in the parameter table, so if you have data using a particular parameter
and you change the name of the parameter, all of the existing data will use the new (edited) name; the data will be
neither lost nor will it retain the original value. If you have 100 manganese data items and you change the parameter
“manganese” to “Fe”, you will now have 100 “Fe” data items. If you have 1000 “Al” data items and you change the
parameter to “Aluminum” you will now have 1000 “Aluminum” data items.

The latter example (Al to Aluminum) suggests a scenario in which you might wish to change a parameter – for
greater clarity to some users. However, do so with caution.

People (Data People)
The people screen allows you to enter and keep track of all people.At this time people are not associated with either
organizations or sites, so this feature has minimal benefit other than providing a way to keep contact information
with the database; this probably only has value when you want to store contact information for people who are
directly associated with the data in the database.

This is a “standard” listed screen; that is, a list of existing entries appears in the box on the left of the screen and you
can click on any name to make it the active person. You can edit the active person and keep track of the following
types of data:

1. name prefix (e.g., Mr., Dr., Ms)
2. first name
3. last name
4. name suffix (e.g., Jr., III)
5. 3 lines of address information
6. City
7. State

8. zip
9. zip4
10. phone
11. extension
12. (primary) email address
13. free form notes
14. active status (y/n)
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Points (Data Points)
The Point screen is expected to be the primary data entry screen. The screen has three parts to it. The upper left has a
list of the points for the active site, the upper right has the point specific data, and the lower half of the screen
contains a grid of sampling data.

The listed area (upper left) performs the same as with any “listed” screen: clicking on one of the items in the list
(upper left) will change the active item.

The point data contains some basic point data including a name, latitude, longitude, elevation, and comments. It also
identifies the area and site to which it “belongs.” The latter two items are displayed, but are not editable. The latitude
and longitude can be entered as either decimal degrees or  D M S format. To do the former, enter all data in the
leftmost box of the set for each. If data is entered into each box, then the data is expected to be entered in D M S
(degrees, minutes, seconds). A value will appear to the right of the text boxes which will represent the decimal
degree version of the same data. This can be seen in Figure 3 below.

The Type field is of critical importance, as is discussed elsewhere in this document. The sample grid will not appear
until the type is selected. Any time you change the type value, you will be asked if you want to make the change. If
you choose to change the type, then the sample grid will change to reflect the parameters specified for the new type.

The sample grid is an editable grid. It conforms to the standard grid “protocol” with two exceptions:
1. You can add qualifiers to your numeric data. The valid qualifiers are >, <, and E. Any other value will get

an error message. The three qualifiers are intended to be used to indicate that the actual value is either less
than (<) or greater than (>) the entered number or to indicate that the value entered is Estimated (E).

2. If you enter a value which is greater than the highest value specified for the parameter or less than the
lowest value specified for the parameter, then you will be warned that your data is invalid and will be
notified why the data is not acceptable. You will need to change the value before you can leave the cell. For
example, if a value of 15 is entered for lab pH, then the application will give you an error message

indicating that  

The second item above points out why it is critical to properly define the bounds for your parameters. When in
doubt, make the bounds broad.

At the bottom of the second section, and above the sample grid, will be either a description of the current filter (e.g.,
“Listing points for Site XXX” as in the sample below) or, if you are editing data in the sample grid, the date of the
current row in the sample grid.
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Figure 3 Sample point screen

Results (Data Results)
The results screen allows you to look at any set of data across all of the data for the active filter. When no filter is
applied, this displays the specified fields for all of the records in the database.

To view results, you must first select which fields to display in the results grid. To select a field to display in the
grid, check the box to the left of the field name. The checkboxes in the “Define” list behave the same as most
windows checkboxes: if you click on an unchecked box, it will check it; if you click on a checked box, it will
uncheck it.

Once you have selected all of the fields that you want to display, you can click on the Results tab (or hold down the
Alt key and press R). This will cause the program to go to the database and get all of the data to display.

At this time, the order of the fields is rigid. It will appear exactly in the order that it appears in the list on the Define
tab.

If you expect to want to view a particular set of  fields more than once, it might make sense to save the result
definition. To save the result definition, enter a name for the result set (where it currently says “Not saved”) and
press the save button on the toolbar ( ) or select Save from the File menu. The result set will be saved using
the name that you have selected.

One exception to this is if the result set definition already exists. If the result set already exists, then the program will
let you know that a result set with that name already exists and ask you if you want to overwrite it. To overwrite it,
press the Yes button. If you do not wish to overwrite the existing result set definition, press the No button. After
pressing the No button, you can change the name of the definition and try saving again.
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To use an existing result set definition, press the Open icon on the toolbar ( ) or select Open from the File
menu. A list of all saved result set definitions will appear. Click on the one that you would like to use and
press the OK button.  If you change your mind and do not want to load a result set definition, then press the Cancel
button. If you choose to load an existing result set definition, then the parameters for that result set will be selected
in the list on the Define tab.

You can clear the selection of fields by pressing the new button on the toolbar ( ) or by selecting New
from the File menu.

NOTE: The Results grid will not update until you switch from the Define tab to the Results tab; this may require
you to switch to the Define tab first if you are already on the results tab.

Sorting
You can change the order of the results by clicking on the column heading that you wish to use to sort the results.
The mouse pointer will change into a black downward pointing arrow when you can do this. If you click on a
column heading when the mouse pointer is the downward pointing arrow, a dialog box will appear which asks
whether you wish to sort in ascending or descending order. Press the Ascending button to sort the results on the
selected column in ascending order; press the Descending button if you wish the results sorted in descending order,
and press the Cancel button if you don’t really want the data sorted on the selected column.

Charting
The charting feature is currently very rudimentary. You can chart results data in one of three formats: bar, line, or X-
Y scatter. The data which is displayed is dependent upon the data currently in the results grid.

To chart the data, press on the chart icon in the results screen toolbar (. ).

When the charting screen appears, you will see three tabs on the left side of the screen. These tabs are Data, Scale,
and Type.  The Data tab will list all of the numeric fields from the current result set. The Scale tab currently has only
one option avalable: actual numbers. The Type tab allows you to select what type of chart you want graphed; current
options are bar, line, and scatter.

To select fields to display in the chart, click on the fields listed in the Data tab. Clicking on an unselected field will
select it. Clicking on a selected field will unselect it.

To select a chart type, click in the radio button to the left of the type of chart you would like to see.

The chart will automatically refresh after you have made changes. If, however, you are the impatient type, you can
also press F9 to force a refresh.

The chart can be resized and moved around within the charting area. This has value when you wish to change the
placement and/or size of the area used to display the legend. Any other value has yet to be discovered, unless you
happen to derive pleasure from virtual silly putty. ☺

Site
The site screen is intended to retain data related to the second tier of locations. Sites must belong to an area (you
cannot add a site unless you already have an active area).

This is a “standard” listed screen; that is, a list of existing sites appears in the box on the left of the screen and you
can click on any name to make it the active site. You can edit the active site and keep track of the following types of
data:
1. Name This is the name that the application will display whenever you are searching for a site.
2. Common Name This is included to provide a second name which may be used by participants in addition

to the “primary” name.
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3. Permit This was included to represent a permit number for the site. At this time there is no
provisions for multiple permits on a site, so in those instances you will need to determine
whether you want to identify permits as separate sites or not. Recommendations on any
issue related to this can be sent to wamp@newmilesofbluestream.com
This field was made large enough to enter multiple permit numbers, if that approach is
desired.

4. Area This is a non-editable display of the area within which a site appears.
5. Organization You can assign a site to an organization. Organizations must first be added via the

organization screen to appear here.
6. County(ies) This displays the counties in which the site exists. See below for additional information.
7. Township(s) This displays the townships in which the site exists. See below for additional information.

The county and township boxes are an oddity. You cannot edit these boxes directly, but if you double click on the
appropriate box, the list of items for that box will appear. That is, double clicking on the county box will cause a
listing of all counties that you have entered to appear; double clicking on the township box will cause a listing of all
townships (again, that you have entered) to appear. Once you have selected one or more items from the pop-up
dialog and pressed the OK button, the item(s) selected will appear in the respective box.

The pop-up dialogs both contain a list of possible values. To select more than one of these items, hold down the Ctrl
key and click on multiple items. If, for some reason, you wish to select a range of items, then click on the first one,
hold down the Shift key, and click on the second one. In the latter scenario, all items between the two items should
appear with the highlight color.

Townships (Define Townships)
This screen allows you to maintain the name of townships and notes related to the township. Townships can be
added or edited using the standard techniques for a grid.

Types (Define Types)
This is a slight variant on the “standard” listed screen; that is, a list of existing sites appears in the box on the left of
the screen and you can click on any row to make it the active type. Once you make a type “active,” then the list of
parameters on the right will change according to what parameters have been selected to be part of a type.  The list of
parameters will always be the same: it will list all parameters; the difference will be in which  parameters have been
checked/selected. In version 1.01 this list appears in the same order that the parameters were entered. In version 1.02
and beyond, the list of parameters will appear in alphabetic order.

Enter the name and description for the type in the grid on the left. The grid performs the same as standard grids. To
add a new type, enter a name in the last row. The last row has an asterisk in the record selector at the left of the grid
(much as the active row is identified by a right facing triangle as can be seen in the figure above).

To add a parameter to the list of parameters associated with a grid, click in the box to the left of the parameter name.
This behaves the same way that a “check box” normally behaves in Windows programs: clicking on a checked box

Figure 4 Define types
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will uncheck it, clicking on an unchecked box will check it. All parameters which have a checked box will be
considered to be part of the type.

Undocumented features
OK, this is documenting them, but I usually refer to “bugs” as undocumented features. It seems much more
civilized, and a lot less condemning☺. The following items are all behaviors that the program exhibits which are not
in line with expectations. It is important for you to know what these are in case you stumble across one of them.

These are items that have been noted and are on a list for future correction. None of them should keep you from
using the program; nor should they corrupt your data. However, you may need to take corrective action to prevent
undesirable side effects; the corrective action will be listed with any noted “feature.”

IF YOU FIND a feature NOT in this list, then we would appreciate it if you were to write a quick description of
what you were doing, the time the error occurred, and a short description of the error and send that information
along with the nmbs_wd.err file on your machine to wamp@newmilesofbluestream.com. Please only send errors,
not lists of behaviors which are not the same as what you would like to see.

1. The list of possible items that appears on the left side of the site, point, people, and organizations screens
sometimes gets out of synch with the data that is being displayed on the form. If this happens, close the screen
and re-open it. If you happen to note the cause of this, please report it. To date, we haven’t been able to identify
a consistent cause.

2. You cannot load an advanced filter as the default filter. It will not load properly.

Future enhancements
Since this is a service we are providing for free, there is no guarantee that changes will be made. However, we have
already noted a number of enhancements we would like to see in a future version of the software. At this time, we
are not making the code open source either since the developer describes the code as a patchwork of fragments of
code which are inelegant and “kludgy”.

Caveats aside, we have the following items planned:
in version 1.1:
1. Sample deletion: The ability to delete samples
2. Parameter ordering in types: You will be able to specify not only which parameters define a type, but also the

order in which they are included. This will have particular value when you define a type to coincide with a
hardcopy report.

3. Field ordering in results: You will be able to specify the order in which fields will appear in the results grid.
4. Sampling plans: You will have the ability to create sets of points to enter data for periodically (e.g., monthly

sampling, quarterly sampling … ) and then enter sampling data for a sampling plan. This will be superior to the
current arrangement because it will allow you to enter data for a single date across sampling points much as the
current grid allows for entry for a single point across dates.

5. DB compact/DB repair: These are the same as database compaction and repair in Microsoft Access. You are not
likely to need to compact databases since the design of the program uses a temporary database for most of the
things that cause Access database to grow. However, if a database is damaged, you will need to be able to repair
it.

6. Add “Not null” to advanced query comparisons.
in version 1.2
1. Range selection in grids. This will allow you to select a range of cells in a grid much the way you expect to be

able to do in a spreadsheet program.
2. Range copy, cut, and paste in grids or, at the very least, these features in the sample grid on the point screen.
3. Reporting: The ability to add and run reports.
4. List management: The ability to manage the data in the lists. This may and may not be added since current lists

are all managed through specific forms (e.g., counties and townships).
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5. filter and result set management. This is also questionable. However, there may be a benefit to allowing you to
manage these items directly and independent of any particular NMBS WaMP database. Currently the items are
maintained in their own database.

Technical notes (of a sort)

Software
This program is a quick & dirty application which we created using a bunch of code from projects that date back as
far as 1998. It was written in Microsoft Visual Basic and should run on any version of Windows from Win 95
through Windows XP. However, we have not tested it on all of these platforms.

The database is a Microsoft Access 97 database. If you have a newer version of the database and wish to access it
directly, do so by linking the tables – do not convert the database to a newer version of MS Access; the program
will not work with your data if you do so.

NOTE: This program was not written or tested for multi-user access. It may work with multiple users, but that may
cause odd errors.

Security
This section presumes familiarity with the “security” provisions provided by Microsoft Access. Indeed, you must
own a copy of Microsoft Access in order to implement security. If the issues presented here do not make sense, then
you should refer to the Access manual or a third party book which documents how to work with security in MS Access.

The default database is not secured or protected in any fashion. Anyone with access to the database and a program
which allows access to the Microsoft Access file format can make changes to the database. This provision was done
because (a) we presumed that security would not be an issue for most people, and (b) any security provisions we
implemented would make the database less secure in those environments where security is desired/required.

The best approach for securing your database is to follow these steps:
1. Create your mdw file.
2. Add a user ID named “superuser” to your security configuration which has Admin rights.
3. Copy it over the nmbs_wd.mdw file which is provided with the database.
4. Run NMBS WaMP
5. Create a new database
6. Close out of NMBS WaMP
7. Open the new database in Microsoft Access and apply the appropriate security to the database, tables, and

queries in the database. Make certain to apply the security provisions for new queries and tables so that any user
can create a table or query.

8. Relaunch NMBS WaMP and login with a user/password pair from your new mdw.


